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Lab 9: Using Oracle Data Sync

Oracle Data Sync is a client tool that uploads data from files, relational tables, and OTBI (Oracle Transactional

Business Intelligence) to a variety of Oracle Cloud Services including ADWC.

Oracle Data Sync can connect to over 20 different Databases and other sources, and load data into any Oracle
Cloud Service.

Use Data Sync when you want to:

Load data from a variety of data sources, such as CSV, XLSX, Oracle databases and non-Oracle sources.
Perform incremental data loads into ADWC.

Merge data from multiple sources during loading.

Transform data while loading.

Schedule the data loads.

Perform insert-only or append strategies.

In this lab you will use Data Sync to load data from an Oracle Database to ADWC.

Objectives

Configure connection to ADWC using Data Sync
Load a table residing in an Oracle Database to ADWC

Perform incremental data loads into ADWC



Required Artifacts

e The Lab requires an Oracle Autonomous Data Warehouse Cloud subscription.
o Locate your Cloud Account Name, Username, and Password.

e Access to the Lab VM.
o Locate the Lab VM's IP Address, User Name and Password

e Connection to a source Oracle Database

o Locate the Oracle Database User ID and Password provided to you by the instructor for the Data
Sync Lab.

Lab Steps

Step 1: Start Data Sync

¢ Sign in to the Lab VM using the credentials provided to you by the instructor.

o Start Data Sync by clicking on DataSync.bat on the desktop.

s

DataSync.bat

If starting Data Sync for the first time, it will create a Repository and will prompt for a Repository Name
and a Password. In the Lab environment the Repository is pre-created and the password is saved.

¢ On the Enter Password pop-up, note that the password has been already entered and saved. Click
Login.



<) Oracle Analytics Cloud Data Sync bli-

Enter Password

Enter the Oracle Analytics Cloud Data Sync passwaord.
You specified this password during the configuration
process.

Password: [uuo- ]

Remember password

e Select Create a New Project, enter DBCS_TO_ADW as the project name and Click OK.

@ [ Welcome == s

A project is a container for metadata which defines
sync hetween an on-premises source and a cloud source.

® Create a New Project:
DECS_TO_ADWW

{0 Select an Existing Project:

() Skip Create/Select a project

["] Do Not Show at Startup

Step 2: Create Connection to ADWC (Target)

In Data Sync, use the Sources/Targets dialog in the Connections view to specify connections details for your
target database and your source databases. Data Sync loads data from these sources to the target location.

Note: If you're loading data only from data files, for example XLSX or CSV format, then you don’t need a
connection in Data Sync.

You need to create two connections for this Lab, one for the Source Oracle Database, and one for the Target
Autonomous Data Warehouse Cloud Service Database.

¢ Create the connection to ADWC which will be the Target.

e Click Connections and then click New.



Projects Views Tools Help

Icmm Ptojectl ml
| Sources/Targets |

LNy @ save jundo | T
| Create new record | Ct

¢ In the New Connection window enter the following:

o Name: ADW
o Type: Oracle (Thin)

Oracle Bl Connector

Oracle Service Cloud (RightNow) | ¥
| ok || cancel |

¢ Do not select any of the Options presented. Click OK. This will add the ADW Connection.

) Known URL and Driver

) Help with URL and Driver




o Ensuring that ADW is selected in the upper half, enter the following in Edit tab in the lower half:

o User: ADMIN

o Password: Enter the Password for ADMIN specified earlier

o Schema/Table Owner (Optional): ADMIN (Uppercase)

o Click on JDBC Driver and enter the following in the pop-up and click OK:

oracle.jdbc.driver.OracleDriver

e This is how your Edit tab should look so far:

Edit | Description | Advanced Properties r Refresh Dates ]

Name: Connection Type: User:
ADW \ ’Oracle (Thin) b [sDMIN
Password: Connection Name: URL:
JDBC Driver: SchemalTable Owner (Optional): Catalog (Optional):
oracle.idbc.driver.Oracle... 4| ADMIN [ ‘
Time Zone: Source Priority:
4 [4 |

¢ Next, browse to the following folder in ORACLE_HOME in the Lab VM:

C:\12c_client\product\12.2.0\client 1l\network\admin

¢ View the contents of the thsnames.ora file.

- admin [= ==
W o e e o

(& v 1 l <« Windows (C:) » 12c_client » product » 12.2.0 » client_1 » network » admin v & Search admin L ‘
© Favorites MName - Date modified Type Size
B Desktop sample File folder

% Downloads || cwalletsso SSO File 7KE

= Recent places | cwalletsso.lck LCKFile 0KB

j,l ewallet.p12 Personal Informati... 7KB

1 This PC . ewallet.p12.lck LCK File [

i Desktop || keystorejks JKS File 4KB

~| Documents | ojdbc.properties PROPERTIES File 1KB

& Downloads | sqinet.ora ORA File 1KB

W Music | sqlnet1805015PM2546.bak 25 PM BAK File 1KB

= Pictures J tnsnames.ora 811:00PM ORA File 37KB

H Videos || truststore jks 5/2/201811:00PM  JKSFile 4KB

i Windows (C:)

€ Network

Thiterns 1 item selected 36.6 KB =

e You may see many connections defined in this file. For each individual ADWC database end point, there
should be 3 entries, with each entry corresponding to the database service name for ADWC.



¢ Locate the service name entries for your ADWC Database, and more specifically the service name that
ends with Low. Copy the text starting from "(DESCRIPTION" to the end of connect string.

£k tnsnames.ora - Notepad ==

File Edit Format View Help

partners_high = (description= (address={protocol=tcps)(port=1522)(host=adwc.oraclecloud.com)) (connect_data={servi »~
"CN=adwc.uscom-east-1.oraclecloud.com,OU=Oracle BMCS US,0=Oracle Corporation,L=Redwood City,ST=California

eI s IR Il (description= (address={protocol=tcps)(port=1522) (host=adwc.oraclecloud.com)) (connect_data=(serwvici

“CN=adwc.uscom-east-1.oraclecloud.com,0U=0Oracle BMCS US,0=Oracle Corporation,L=Redwood City,ST=California

partners_medium = (description= (address=(protocol=tcps)(port=1522)(host=adwc.oraclecloud.com))(connect_data=(ser'
"CN=adwc.uscom-east-1.oraclecloud.com,OU=Oracle BMCS US,0=Oracle Corporation,lL=Redwood City,ST=California

¢ We need to add the connect string you just copied to the URL text box in the Edit tab. Click on URL and
enter the following in the pop-up:

jdbc:oracle:thin:@

¢ Next to the "@" sign, paste the contents that you copied earlier. Your constructed connect string should
like below.

jdbc:oracle:thin:@(description= (address=(protocol=tcps) (port=1522) (host=adwc.oraclec
loud.com) ) (connect data=(service name=partners low.adwc.oraclecloud.com)) (security=(s
sl server cert_dn=

"CN=adwc.uscom-east-1l.oraclecloud.com,0U=0Oracle BMCS US,O0=Oracle Corp
oration,L=Redwood City,ST=California,C=US")))

¢ Click OK to close the URL dialog.

@ URL -
Ll

'dbc:0racle:’[hin:@kdescriptinn: {address=({protocol=tcps){port=14522)thost=adwe.araclecloud.com)i{connect_data=(g
"Ch=adwe.uscom-east-1.oraclecloud.com,OU=0racle BMCS US O=0racle Corporation, L=Redwood City, 5T=Cal

<] i | D

¢ Since the ADWC service requires the use of Wallets, we need to add the location of Wallet Credentials Zip



file to the connection. Click the Advanced Properties tab.

Name: Connection Type: User:
[aDw | |oracle (Thin) | v o |
Password: Connection Name: URL:
I....'....... I l @
JDBC Driver: SchemalTable Owner (Optional): Catalog (Optional):
| oracle.idbc.driver.Oracle... | ADMIN i | |
Time Zone: Source Priority:

o [1 |

¢ Click on Advanced JDBC dirver Properties as below:

Edit | Description | Advanced Properties | Refresh Dates
 save| ] Undo | D Search | ¢ Refresn | @ | 2016

Name Value |
|

5000 &

true i
1000000 i
true i)

¢ In the pop-up window, enter the location of cwallet.sso, which in our case is
%0ORACLE_HOME%/network/admin (from Lab 2). Enter the following in the pop up box:

oracle.net.wallet location=file:C:\12.1 client\network\admin

e Enter OK.

oracle.netwallet_location=file:C:\12.1_client\network\admin




¢ Click Save to save the changes.

| Edit [ Description T Advanced Properties | Refresh Dates

save | (5] Undo | D Search | ] Refresh | @

e Test the connection. Click on the Edit tab and click Test Connection.

[ Edit I Description T Advanced Properties | Refresh Dates

Name: Connection Type: User:
ADW | [oracte crhin) | > | DN \
Password: Connection Name: URL:

idbc:oracle:thin:@(descri... i

JDBC Driver: SchemalTable Owner (Optional): Catalog (Optional):
oracle.idbc.driver.Oracle... 4| ADMIN 4 ‘
Time Zone: Source Priority:
o f |

Save Test Connection Undo

¢ You should get a Connection Successful! message. Click OK.

@ Connection Successful! -

Connectivity Information:
Database:
Oracle Database 18c Enterprise Edition Release 12.2.0.1.0 - 64bit Production

JDBC Driver:
Oracle JDBC driver
Version:

12.2.01.0

Step 3: Create Connection to the Oracle Database (Source)

The Source Database used in this lab resides on an preconfigured Oracle Database Cloud Service (DBCS)
instance in the Oracle Cloud. The schema used as the source for this lab has been prepopulated with sample
data. The connection to the DBCS source has been preconfigured as DBCS.

e From the Connections tab, click on DBCS in the Sources/Targets section.



Connections Project | Jobs

J' Sources/Targets ‘

[ ] New Save ” o] Undo | [ Delete | 2 Searcn‘ %] Refresh H [©)]

Name Connection Type User Connection Name URL
ADW Oracle (Thin) ADMIN jdbc:oraclethin:@(description= (a i
DBCS Oracle (Thin) USER_X( jdbc:oracle:thin:@DESCRIPTION... i
File source File source g
TARGET Oracle (BICS) %)

¢ Click the Edit tab towards the bottom half of the window and enter the following:
o User: User ID (Supplied to you by the instructor)
o Schema/Table Owner (Optional): User ID (same as above)
o Do not change the password as the password has been saved already

¢ In the screenshot below, observe that the User ID used is USER_02 (Replace this with your own).

&7

Name: Connection Type: User:

[beCS | |0racle (Thin) |v| |user 03] 1
Password: Connection Name: URL: :
[.l..l..l.... I idbc:oracle:thin:@(DESCR... \.'_’]
JDBC Driver:

Catalog (Optional):

| l

| oracle.idbc.driver.Oracle... 4 |U

Time Zone: Source Priority:

] |

e Click Save.

" Sources/Targets |

e[ e ) unto| 5 oot seareh| ¢ versn @)

¢ Click Test Connection to validate your connection.

Save I Test Connection Undo




© Connection Successful! -

Connectivity Information:

Database:

Oracle Database 12c EE Extreme Perf Release 12.1.0.2.0 - 64bit Production
With the Partitioning, Automatic Storage Management, OLAP, Advanced Analytics
and Real Application Testing options

JDBC Driver:
Oracle JDBC driver
Version:

12.2.0.1.0

¢ You have now successfully configured the connections to both the Source DBCS and the Target ADWC.

Step 4: Configure Data Load Options on the Source Tables

¢ First we need to add tables from the Source database. Select the Project tab and click on
DBCS_TO_ADW project that was created in Step 1.

Projects Views Tools Help

Connections || Project] Jobs | |DBCS_TO_ADW | v || [»] Run Job

DBCS_TO_ADW

1 Source Data [Target Objects f ng T Parameters I

If you do not see the DBCS_TO_ADW Project, you need to create it by clicking on Projects -> New.
Enter the details specified in Step 1 of this Lab.

¢ Under Source Data click on Data from Object(s).

Source Data | Target Objects ' Pre/Post SQL Processing ’ Parameters [ Project S y ‘
‘ [l pata From Object(s) ¥, Manual Entry Q New Target Object‘ E"}, Update Definition Save
Import data from objects P

¢ In the pop-up box choose DBCS as the source. Click OK.



®

Projects Views Tools Help

ks ”— y—l—l
- Connections || Project Jobs | |DBCS_to_ADW | v || 2] Run Job

[ Source Data | Target Objects | Pre/Post SQL Processing | Parameters | Project Summary |

| [ pata From Object(s) | #: Manual Entry | B New Target Object | 5% Update Definition | & Save |

¢ Select Discover objects by listing. Click OK.
¢ In the Import Definitiion pop-up, click Search to get a listing of all tables in the Schema.

e All tables in the schema will be listed. Click Select All and then Import. This will import the table
definitions to the Data Sync repository.

Source Filter

Lk [~] [

List

Name Import Definition
WORKSHOP_BIG1 v/
WORKSHOP_DUP
WORKSHOP_SMALL

RRIEX

OutputFormat:
[t ][ imoort ][ canct |

l Search I

¢ Click OK when prompted with the below message:



DATA EXTRACT:

'Source Objects may contain a lot of attributes, not all of the attributes will
be needed for analysis.Itis advised that only those attributes that are
needed for analysis are loaded into target.

'You should consider defining indexes as necessary for relational type
targets to improve the performance of reporting.

¢ Wait for the tables to be imported.

Import Definition into DBCS_TO_ADW [x]
Source Filter
[oBcs [=] |
List
Import Definition
WORK Please wait...
WORK: | | [
|
oo [

¢ All the 3 tables will appear in Data From Object(s).

Projects Views Tools Help

IProject Jobsl DBCS_TO_ADW | v || [»] Run Job

Source Data | Target Objects | Pre/Post SQL Processing | Parameters | Project Summary |

¢, Manual Entry | B New Target Object | §? Update Definition | [ Save

Connections

PluggableObject WORKSHOP_DU
PluggableObject WORKSHOP_SMALL

< i ] [»

o e 3

Edit | Description | Columns [ Targets | Attributes

Name:
|ab|eObjectWORKSHOP_BIG1|




¢ Next, set the strategy for loading duplicate rows. Let the strategy be that we eliminate duplicate rows
during the load and insert only unique rows based on User Keys column OBJECT_ID.

¢ Click on WORKSHOP_DUP table and then the Target tab in the lower half of the window.
¢ Double click on Load Strategy.

e Check Remove duplicates, Update table, add new records and Update existing records as show

below:
@ Load Strategy -
av [_] Never delete data
[ Edit | Description | Columns | Targets | ttributes | ] Remove duplicates
Idl Save | &3] Undo | [ Delete | .J Search | ] Refresh % Map Columns | @ Load Strategy:
Connection [ Table | Load Strategy - Replace data in table
DBCS ‘WORKSHOP_DUP ‘ Replace data in table [ Append data to table
® Update table
[v] Add new records
[v] Update existing records
[ ok |[ cancer || @

e The Update table option selected earlier allows incremental loading on the table.

Incremental loads are based on a date/timestamp filter column. Data Sync records the time of the
previous run and filters on a date column to pick rows that are greater than the recorded time.

¢ Click OK.

¢ Configure the incremental load options on the Incremental Settings pop-up. Under the User Keys tab,
choose OBJECT_ID and click ">>". OBJECT_ID will be the unique id based on which duplicate columns
will be removed.



[ User Keys | Filters |

Columns: User Key Columni(s):
CREATED OBJECT_ID
DATA_OBJECT_ID
EDITIONABLE
EDITION_NAME
GENERATED
LAST_DDL_TIME
AMESPACE
OBJECT_NAME
OBJECT_TYPE >
ORACLE_MAINTAINED
OWNER
SECONDARY
SHARING [:g
STATUS
SUBOBJECT_NAME
TEMPORARY
TIMESTAMP

<<

| ok || cancel |

e Click the Filters tab, choose LAST_DDL_TIME and click >> . If rows are updated on the source table,
Data from the table will move be loaded to Target if the Filter column is updated as well.



[ User Keys | Filters |

Columns: Filter Column(s):
REATED LAST_DDL_TIME

>

<<

| OK || Cancel |

¢ Click OK.

¢ A pop-up will suggest that building additional indexes can improve performance of incremental loads. Click
Ignore to ignore the suggestion for now.

2 Lﬁn index on user key columns can help in improving incremental load performance.
- . ) .
Wvould you like to register such an index?

WORKSHOP_DUP_AU1 UNIQUE: true BITMAP: false NUM UNIQUE COLUMNS: 1
COLUMNS:
OBJECT_ID:1:Asc

| Create Index | Ignore

e Similarly, you can navigate to the other tables and investigate the load stratergy.. By default all tables will



have a replace data in table option set.

Step 5: Run the Initial Load

o Create a new Job that will load the tables you have just defined. Click on Run Job at the top.

Projects Views Tools Help

Connections | Project

Jobs |DBCS_TO_ADW |w (| [»] Run Job }l

Since this is the first Job we like to run, a New Job window will pop-up.

Uncheck the Drop/Create Indexes checkbox. Checking this column will attempt to create a unique index
to speed up de-duplication. Click Next.

© New Job -

Job name: IDBCS_TO_ADW-Job1 |

Number of Retries | |

Number of Parallel Tasks |10 |

Cloud Connection | I v l

[ | DropiCreate Indexes

[_| Analyze Objects

| Next> H Cancel H @ |

IMPORTANT If you forget to uncheck this option, Data Sync will try to create an unique index in Target
ADWC to speedup incremental loading. However since ADWC currently does not support the creation of
indexes, You will see an error in the Job Details

¢ For the Target datasource, choose your ADW connection. Click Finish.



For any or all of the data sources, select a data source as an override for the instance.
Data Source Override With

DECS

TARGET "7
DBCS
File source
TARGET

<Back Finish Cancel @
|

¢ Your first job is being compiled and run.

Projects Views Tools Help

Connections

@[I DBCS_TO_ADW |+

[Jobs | schedules | Runs

‘[EIResmnHOAbonHEsave”.@unao”,’)searcn”@aeﬁesn”@\ 1of1
ProcessID |  ExecutionPlanName | #C [ Duration | Runstatus | start | End | status Description
25446182 TO_ADW-Job1 | | 10 sec(s} 19/18 11:01:34 PM Executing steps.
Tosks | uat 1o |
| & save | ] undo | 2 searcn | ] Refresn |  petaiis| @ | [an [~] 003
Depth Name [ Mode Duration | Stage Rows | SuccessfulRows | FailedRows | TaskStatus |  Status Description | Start Timestamp | End Timestamp
0|CR_WORKSHOP_DUP_FROM_D...|Source : FULLT..| 5 sec(s) 0 0|Running 5/19/18 11:01:40 PM
CR_WORKSHOP_BIG1_FROM_D..[Source :FULLT..| 5 sec(s) 0| 0|Running :[5119118 11:01:40 PM
.| 5sects) 0 0[Running d[5119/18 11:01:40 PM

¢ In a few seconds, your Job will complete and you will observe the following three tasks in the lower Tasks
tab:



2

Oracle Analytics Cloud Data Sync (Workshop_repository)

Projects Views Tools Help

=i

—
Comnections | Proect | Jobs | DBCS_T0_ADW |~ | (] Run Job LEE)
|
[ Jobs | Schedules | Runs |
[2] Restart| @ Avort| & Save | \5] Undo | ;O Search | & Refresh | @ 101
Process ID Execution Plan Name #CompletedFailed/Total Duration Run Status Start Timestamp End Timestamp Status Description
25446182|DBCS_TO_ADW-Job1 ] 3(100%)10 (0%)13) 2min(s), 12 sec(s)Completed __|519118 11.0134PM___|5119/18 11:03:47 PM Finished &
[ Edit Description Tasks | Audit Trail
save | 5] Undo | D searcn | ] Refresn | I etais| @ | [an ~] 00f3
Depth Name Mode Duration | Stage Rows | _SuccessfulRows | FailedRows | TaskStatus | Status Description | _Start Timestamp | End Timestamp | Source Databas
0[CR_WORKSHOP_DUP_FROM_D...|Source : FULL T..|2 min(s), .| 3512997 3512997 o[Completed_|Successfully comple... E5/19/18 11:01:40 P |5119118 11:03.42.|DBCS
0|CR_WORKSHOP_BIG1_FROM_D...|Source : FULL T...|2 min(s), 3512998 3512998 0/Completed comple... 45/19118 11:01:40 PM |5/19/18 11:03:47..|DBCS
0[CR_WORKSHOP_SMALL_FROM... [Source : FULL T..| 42 sec(s), 87825, 87825, o[Completed _|Successfully comple... e45/18/18 11:01:40 PM [5119/18 11:02:23..[DBCS

¢ You have now successfully loaded the 3 tables.

o WORKSHOP_BIG1 has about 3.5 million rows and is about 500 MB in size.

o WORSHOP_SMALL is a small table with about 87K rows.

o WORKSHOP_DUP has about 3.5 million rows in the source, but only about 87K rows in target as we

had opted to el

iminate duplicate rows.

-

[ Edit

Description |( basks | Audit Trail |

[ Save | &) Undo | ,J Search | 2] Refresh | [l Details | 2

Depth Name Mode Duration Successful Rows
0|CR_WORKSHOP_BIG1_FROM_DBCS-Pluggah...[Source : FULL Target : FULL 2 min(s), 51 ... 3510278
0|CR_WORKSHOP_SMALL_FROM_DBCS-Plugg... [Source : FULL Target: FULL 29 sec(s) 87757
0|CR_WORKSHOP_DUP_FROM_DBCS-Pluggab...|Source : FULL Target: FULL | 1 min{s), 41 ... 87757

A single project can have multiple jobs. Usually, you would configure a single project to load a single

Target, but the Sources can be multiple.

Step 6: Run the Incremental Load

One of the use cases for Data Sync is to keep the ADWC service in sync with on-prem or other cloud services.

In the previous step, the Load Strategy for WORKSHOP_DUP table was set to support incremental loads. We
will load additional rows on the WORKSHOP_DUP table and use Data Sync to replicate the new rows to

ADWC.

e Start Oracle SQL Developer and Click on New Connection to create a new Connection to the Oracle

Database.



I
File Edit View Navigate Run Team Tools Window

JRoEHE 9@ 0~-O0- & =

Connections

{';'(59 ],]:_é]

@New Connection...
+ admin_

+E3 Source_user_xx
& Orade NoSQL Connections
- Database Schema Service Connections

In the New/Select Database Connection pop-up click on the previously saved Source_User_XX
connection in the left pane.

Change the username from USER_XX to your assigned User name. Keep the same password.

Click Test. If the connection is successful, Status : Success will appear on the lower left of the pop-up.

Click Save and confirm Yes to overwrite the connection.

B New / Select Database Connection &3

Connection Name Connection Detals Connection Name [Source_user_xx
‘admin_ADWC admin@partriers_ow | Username USER_04
Source_user_xx JUSER_D1@//129.146....

password " -
Connection Name in use
[V] Save Passwor

Connection Name already used. Confirm to overwrite
Oracle

Connection Typ:
Yes o Cancel

Hostname

Port 1521
Osp

(3) service name [adw_wkshop.baremetalcloud.network.com

[] 05 Authentication [ ] Kerberos Authentication  Advanced...

Status : Success

Help Save Clear Test Connect Cancel

¢ Next, Click Connect and new SQL Workheet will open.

¢ Run the script below to update and commit the rows.

UPDATE WORKSHOP_DUP
SET LAST DDL_ TIME=SYSDATE
WHERE OBJECT ID BETWEEN 300 AND 400;

COMMIT;



o ox |

2 ) Start Paaq (toy) @dmin_ADWC SQurce_user_xx
;? B9 -8 @8 &¢ & 49 064600003 seconds

‘Worksheet ‘ Query Builder

PDATE WORKSHOP DUP SET LAST DDL_TIME=SYSDATE WHERE OEJECT ID BETWEEN 300 AHD 400

AY

{@Script Output * \

4 é a8 E @ | Task completed in 0.646 seconds

4,040 rows updated.

Commit complete.

¢ We have now simulated some incremental data change in the source. The source table has about 3.5
million rows. The update modifies about 4K rows.

¢ Now switch to Data Sync and click on Jobs then on Run Job.

¢ Click OK on Run Job pop-up.

® Oracle

Projects Views Tools Help

Jobs  |DBCS_TO_ADWY | v || 2] Run Job

[ Jobs [’Schet:lulllsi | Runs |
l'fjﬂew” Sa\n;”@Undo” I D

Name Do you want to run the job "DBCS_TO_ADW-Job1"?

| @ H Cancell

Connections | Project

DBCS_TO_ADW-Joh1

e Wait for your Job to Complete.

Projects Views Tools Help

Project ’E DBCS_TO_ADW | v || [2] Run Job B

Jobs | Schedules | Runs

Connections

‘ [2] Restart H OmnH d save “ \b] Undo “ ~ search H %] Refresh H @] Tof
ProcessID | ExeaionPlanName | #CompletedFFailed/Total | Duration | Runstatus | StatTimestamp End Timestamp Status Description

25446221|DBCS_TO_ADW-Job1 | | 27 sec(s)|Running Executing steps. &

25445182|DBCS_TO_ADW-Job1 | 3(100%)/0 (0%) /3] 2min(s), 12 sec(s)|Completed  |5119/18 11:01:34PM___ 5119118 11:03:47 PM Finished &

iption | Tasks | Audit Trail |
| & save| ] undo| O search | ] Refresh | & petails| @] [an [~] oof

Depth Name [ Mode Duration | Stage Rows | Successful Rows | FailedRows | TaskStatus | Status Description Start Timestamp | End Timestamp | Source Databz
(CR_WORKSHOP_SMALL_FROM... |Swlce SFULLT..| 23 sec(s) 0 0/Running '5/19/18 11:40:37 PM IDBCS

0
0/CR_WORKSHOP_DUP_FROM_D... |Source : INCRE...| 23 sec(s) 0 0/Running 15119118 11:40:37 PM DBCS
0|CR_WORKSHOP_BIG1_FROM_D... Source : FULLT..| 23 sec(s] 0 0| 0|Running 5/19/18 11:40:37 PM IDBCS




¢ Ensure that the Tasks tab is selected on the lower half of the window and observe 4040 rows were
updated in the Incremental mode. The other two tables were appended with additional rows as the
incremental settings were not in effect.

Projects Views Tools Help

EElE CRE]

Jobs | Schedules | Runs |

Connections.

Elnemn\OAmnH Save”.allndou,)Searcn”@ﬂefmsn”(i‘ 102
ProcessID | ExecutionPlanName | #CompletedFailed/Total [ Duration | Runstaus |  StariTimestamp | EndTimestamp | Status Description

25446221|DBCS_TO_ADW-Job1 3(100%) /0 (0%) /3| 1 min(s), 31 sec(s)Completed __|5/19/18 11:40:32PM 5119118 11:42.04PM_| Finished i

25446182|DBCS_TO_ADW-Job1 [ 3(100%)/0 (0%) /3] 2min(s), 12 sec(s)|Completed __[5/19/18 11:01:34PM___|5119/18 11:0347PM_| Finished i

Edit | Description | Tasks | Audit Trail |

Save | 5] Undo | 2 Search | ] Refresn | 1 etails | @ | [an [=] 0B

Depth Name Mode Duration | Stage Rows | SuccessfulRows | FailedRows | TaskStalus | Status Description | _Start Timestamp | End Timestamp | Source Databas|
0[CR_WORKSHOP_SMALL_FROM... |Source : FULL T..| 34 sec(s), 87825 87825| o[Completed £45/19/18 11:40:37 PM |5119/18 11:41:11._|DBCS
0[CR_WORKSHOP_DUP_FROM_D...|Source : INCRE...|_33 sec(s)} 404 4040 o[completed le... (:4/5/19/18 11:40:37 PM 5119118 11:41:10..|DBCS
0[CR_WORKSHOP_BIG1_FROM_D..Source : FULL T... 1 min(s), 3512008 3512998 o[Completea mple... (/5119118 11:40:37 PM [5/19/18 11:42:04..|DBCS

[l I [

¢ Click on the row that was loaded with Increamental Target Mode and click on Details.

Projects Views Tools Help
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25446221/DBCS_TO_ADW-Job1 3(100%)10 (0%) / 1 min(s), 31 sec(s)|Completed 511918 11:4032PM 5119118 11:42:04 PM
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=
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¢ Observe other details on the Import Job, including Duration, Throughput and Errors.



[ Task Details |  Audit Trail (RO)
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¢ You have successfully moved data from source DB to ADWC and configured the Job to do incremental
loads to ADWC.



